OS/390 V2R4.0 BookManager Hints and Tips

A word from the writer .................................................. 1
Searching .......................................................... 2
   Search command or pull-down menu? ......................... 2
   Searching for information .................................. 2
   Refining a search .......................................... 3
   What you see when searching a book ...................... 3
   What you see when searching a bookshelf .................. 4
   "Stray hits" when searching a bookshelf ................. 4
Navigating quickly .................................................. 5
Finding revisions in a book .................................... 5
Printing ........................................................... 6
Cleaning up from printing and other activities .......... 7
Viewing pictures ................................................... 7
Surprises ............................................................ 8
   RETRIEVE key ............................................ 8
   How to "select" an item ................................... 8
   Using F12 to close windows, books, and bookshelves ...... 8
   Variations among BookManager products ................. 8
   Finding hypertext links .................................. 8
   Switching to other ISPF applications .................... 8
Handy options and initial settings .......................... 9
   Sort order ................................................ 9
   Exit options ............................................. 9
   Scroll amount .......................................... 9
   Scrolling through a long list of bookshelves .......... 9
   Setting a "repeat find" function key ..................... 10
A word from the writer

This card was written by a veteran IBM writer who uses BookManager READ/MVS frequently to check his work and research information about OS/390 and related products.

The writer wishes to acknowledge the support of many others who have worked on OS/390, as well as the SHARE customers with whom he has had many discussions about BookManager.

If you wish, send comments about the information in this card to mhvrcfs@vnet.ibm.com.

* The following are trademarks of International Business Machines Corporation in the United States or other countries or both: BookManager, IBM, OS/390.

For product information about using BookManager READ/MVS, see IBM BookManager READ/MVS: Displaying Online Books, SC38-2034 or use the Help pull-down menu.
Searching

BookManager READ/MVS uses “books” and “bookshelves” so that people who have primarily used hardcopy books can readily find information online. Users can “open” a book, or “open” a bookshelf, and find themselves in relatively familiar territory.

While much OS/390 information is still delivered in books and bookshelves, it is useful to begin thinking of books and bookshelves merely as named, dated containers of information. Sometimes it’s better to look for the best chunk of information (“topic” in BookManager READ/MVS) that satisfies your needs.

Search command or pull-down menu?

You can use the search command (abbreviated $) or the Search pull-down menu to perform the same searches. Usually it’s faster to type in a brief, simple command and press Enter than to go through multiple interactions with menus and prompts. Therefore, this document describes how to use commands, except when pull-down menus are the only way to perform a task.

Searching for information

In BookManager READ/MVS, you can search an individual book or an entire bookshelf.

To search a book, enter the search command while the book is open.

To search a bookshelf, enter the search command while the bookshelf is open.

By default as shipped by IBM, and always when searching a bookshelf, BookManager READ/MVS searches use “fuzzy matching.” This means that you are searching for natural-language words or phrases, not just strings:

`s` part
finds part and other forms of the word part such as parts and parting, but not partition or partner.

You can use * to search for any non-matching characters at the end of a word (or for unknown words in a phrase):

`s` part*
finds not only part but also words like partition and partner, along with other forms of those words, such as partitioned.

You can use a comma (,) to separate phrases:

`s` partitioned data set, PDS
finds the phrase partitioned data set as well as the word PDS.
When you do a multiple-word search, such as:

\texttt{s partitioned data set}

BookManager READ/MVS does both ANDing and ORing for you. Topics that have all the words are placed near the top of the search hit list. Topics that have only one of the words are left near the bottom.

The general rule is: Once you've done a search, pause and observe the list of topics presented. Look near the top of the list for the most likely topics.

You can do more complex searches with BookManager BookServer. For OS/390 books on a BookServer, go to the OS/390 home page (http://www.s390.ibm.com/os390) and click on the Library link.

\section*{Refining a search}

To refine a search, enter the \texttt{search} command with no operands:

\texttt{search}

This displays the Set Up Search window, where you can find (and modify) earlier searches. As with most search engines, you can add words or phrases to narrow down the results. Remove words or phrases, or use an \texttt{@} to widen the search.

Once you have opened a book, you can use the Set Up Search window to change the search matching option. The search matching option can be any one of:

- Fuzzy matching
- Exact matching, any case
- Exact matching, including case

When you use the Set Up Search window to specify a search matching type other than your default, the new search matching type is used for only one search. To change your default search matching type, select Set search options on the Options pull-down menu.

Note that bookshelf searches are always fuzzy matching searches.

\section*{What you see when searching a book}

The search hit list is \textit{weighted} so that more important topics are near the top of the list. For example, if a search word appears in the topic heading, or in an index entry within a topic, the topic appears near the top of the list. If a topic includes all the words you entered, within 5 words of each other, that topic is moved ahead of topics that contain only one of the words you entered.

Be sure to press F4 (text) when in a book search hit list. This tells you why each topic was selected (index entry, topic heading, or the line of text containing the search word).

Again, pause and observe the list of topics. Observe the topic numbers and how they relate to each other (topic 3.4.1 is within topic 3.4, but topic 3.4.1 might not appear near topic 3.4 in the list).

There are several approaches to using the search hit list. Here's one way: select a topic that seems likely to be what you want. If the topic doesn't contain the information you want, enter the \texttt{list search} command (\texttt{ls}) to redisplay the search hit list. Then select another topic.
To look for the next occurrence of the current search, enter the `find` command without operands. It can be handy to set a function key to `find`. See “Setting a “repeat find” function key” on page 10.

<table>
<thead>
<tr>
<th>When you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>See why topics match</td>
<td>Press F4</td>
</tr>
<tr>
<td>Select a topic</td>
<td>Move cursor, then press Enter</td>
</tr>
<tr>
<td>Redisplay previous search</td>
<td>Enter the <code>ls</code> command</td>
</tr>
<tr>
<td>See next hit</td>
<td>Enter the <code>find</code> command</td>
</tr>
<tr>
<td>Refine search</td>
<td>Enter the <code>search</code> command, then choose matching option</td>
</tr>
</tbody>
</table>

**What you see when searching a bookshelf**

When you search a bookshelf, you get a list of book “candidates.” Books in this list are ranked by the number of hits in each book. While these are good candidates, the search is not infallible. Pause a moment to read the list of book titles, then select the book you think is most likely to have the information you want.

After you select a book from the list of book candidates, the same search is done automatically **within the book**.

Usually this results in a list of topics that satisfy the search you entered.

If you have opened a book from a search of an entire bookshelf, then close the book, you will return to the search hit list for the entire bookshelf. To conclude the bookshelf search, press F12 again.

Keep pressing F12 until you come to where you want to be (either the bookshelf, the bookshelf list, or even back out of BookManager READ/MVS altogether).

"Stray hits" when searching a bookshelf

Sometimes, searching a bookshelf for multiple words yields what seem to be “stray hits” — books in which no matches are found. This occurs because a search of the bookshelf index identifies books in which all the words appear within the same topic; but a search of a book requires that all the words be within 5 words of each other.
Navigating quickly

Enter, as a BookManager READ/MVS command, the topic name or number that you want to go to. Here are some that might prove useful:

1.0 Go to topic 1.0, which is Chapter 1 unless there are “parts” in the book
1.2.2 Go to topic 1.2.2
CON Go to the table of contents
INDEX Go to the index
INDEX B Go to index entries starting with B
COVER Go to the cover page, which lists the book title and order number
NEXT Go to the next topic
PREV Go to the previous topic
TOP Go to the top of the current topic
BOTTOM Go to the bottom of the current topic
PARENT Go to the next higher topic

Here is a quick way to find “live” hypertext links on a screen: Press the Newline key and Tab key to move the cursor quickly across the screen. When the cursor is on the link you want, press Enter to follow the link.

If the link stays within the same book, press F4 (UNLINK) to return to the previous link.

If the link is to another book, press F12 (or F3) to close the other book. Like UNLINK, this returns you to the link.

Finding revisions in a book

OS/390 books indicate revisions by a revision character in the left margin (usually a vertical bar). To find, in a book, the topics that contain revision characters, use the revisions list command. This shows you a window containing the list of all topics that contain revision characters. Select topics to view just as you do in search hit lists.

Once you have selected a topic containing a revision, you can use the revisions next command to go to the next topic containing a revision. To go back, use revisions prev.
Printing

Make sure to set your print options before printing. To do this, select the Options pull-down menu, then select option 5 (Set print options). Specify the following:

Type of output . . . . 1. BookMaster GML
2. GML Starter Set
3. Carriage control
4. No carriage control

Save the changes as . . . 1. Permanent
2. Temporary

Use the PRINT command to print one or more topics in a book. When you enter the PRINT command, BookManager READ/MVS invokes the ISPF panels you normally use to print at your site, allowing you to print the topics on the printer of your choice.

Enter the command in one of the following ways:

PRINT
PRINT topic1
PRINT topic1 TO topic2
PRINT topic1 FOR number-of-topics

To print the current topic, enter the print command without operands.

To print all of topic 1.0, including its subtopics, enter 2.0, then prev. Make note of the last topic number (for example, 1.6.4), then enter print 1.0 to 1.6.4

To print an entire book, enter PRINT FIRST TO LAST

Sequence of print panels

1. When you issue a PRINT command, the system first displays a panel that contains a List ID field. What you specify becomes part of a print data set name. For example, if you specify test, the system creates print data set ‘hlq.TEST.LIST38PP’. Later on, the system prompts you to keep or delete this data set.

2. When you press Enter, the system displays: a panel that contains a SYSVAR field and a Twopass field. Make sure that the SYSVAR field shows G INLINE S 1 and that the Twopass field shows YES.

3. When you press Enter, the system formats the topics you requested and generates the print data set.

4. When the system displays three asterisks (***), press Enter to clear the screen. The system displays a panel that contains a Print mode field. You can print two ways:
   - To submit a batch job, specify BATCH for the Print mode field, and fill in the Job statement information.
   - To print in the foreground, specify LOCAL for the Print mode field, and fill in the SYSOUT class and Printer ID fields.

Use information provided by your system programmer to fill in the Printer ID, SYSOUT class, and Job statement information fields.
Then, decide what actions to take: print and keep (PK), print and delete (PD),
keep without printing (K), or delete without printing (D); and type the appro-
priate action code in the command line.

Press Enter on this panel to finish the print sequence.

Cleaning up from printing and other activities

Topics you print are placed in a data set. Additional topics you print from the
current book are added to this data set in the order you specify them.

If you wish, you can use normal system facilities (such as ISPF's option 3.4, the
data set list utility) to identify and delete BookManager-related data sets when you
no longer need them. For example, the following data sets were generated as a
result of creating BookManager READ/MVS notes, copying topics, and printing from
OS/390 books:

| hlq1.hlq2.SK2T6700.E0Z1A206.NOTE |
| hlq1.hlq2.SK2T6700.E0Z1A206.COPY |
| hlq1.hlq2.SK2T6700.E0Z1A206.PSEG |

Note: The naming convention used on your system might be different.

Viewing pictures

To see a picture, move the cursor to the phrase PICTURE n, and press Enter. If the
picture is hard to see, press F9 (darker) while the picture is displayed. Or enlarge
the portion you're interested in by zooming in:

1. Press F5.

2. Move the cursor to a corner of the area you want to enlarge and press Enter.

3. Move the cursor to the diagonally opposite corner of the area and press Enter
again.

Press F4 (OrigSize) to return to the original size.
Surprises

RETRIEVE key

BookManager READ/MVS defines F11 as the RETRIEVE key (used to retrieve previously issued commands). If you expect F12 to be the RETRIEVE key, learn to switch within BookManager READ/MVS. Otherwise, pressing F12 to retrieve a command will (surprise!) close the book.

This is why there’s a user option to confirm on exit.

How to "select" an item

To "select" an item, move the cursor to it and press Enter. When viewing a book in a bookshelf, or a bookshelf in the bookshelf list, you don’t need to enter a slash (/) to open the book or bookshelf.

Using F12 to close windows, books, and bookshelves

Most of the time, you can use F12 (Cancel) to close BookManager READ/MVS windows, books, and bookshelves.

Variations among BookManager products

Different BookManager products (READ/MVS, READ/VM, READ for Windows, BookServer) have different interactions. For example, if you’re used to READ/VM, note that some function key definitions vary from BookManager READ/MVS.

Most workstation versions of BookManager (such as BookServer and READ for Windows) allow more complex searches.

Finding hypertext links

A specific color is used to highlight hypertext links. You can use the Options pull-down menu to change the color as desired.

You can also use the Newline key or Tab key as a quick way to find hypertext links.

Switching to other ISPF applications

As with other ISPF applications, when you press F2, ISPF splits the screen horizontally at the cursor position. Doing this lets you use another ISPF application (or, if you like, a second BookManager READ/MVS session) in the other half of the split screen. Press F9 to switch back and forth. You can press F2 again to move the split up or down.
Handy options and initial settings

Sort order
To sort books by book titles, and bookshelves by bookshelf descriptions, select the Options pull-down menu, then select option 7 (Set sort order). Specify the following:

- **Bookshelves**
  1. Bookshelf name
  2. Bookshelf description

- **Books**
  1. Book name/Document number
  2. Book title
  3. Book build date

Save the changes as
  1. Permanent
  2. Temporary

Exit options
To avoid the exit confirmation prompts, and to avoid creating bookmarks in every book you open, select the Options pull-down menu, then select option 10 (Set exit options). Specify the following:

- **Exit from book**
  1. Confirm exit
  2. Do not confirm exit

- **Setting of bookmark**
  1. Keep current closing bookmark
  2. Place the closing bookmark
  3. Exit without closing bookmark

- **Exit from bookshelf and bookshelf list**
  1. Confirm exit
  2. Do not confirm exit

Save the changes as
  1. Permanent
  2. Temporary

**Note:** Remember that, with these settings, if you are viewing any section of a book and you press F12, you will close the book.

Scroll amount
Just as in ISPF, it is helpful to change from **SCROLL ===> PAGE** to **SCROLL ===> CSR**. This lets you move a spot to the top of the screen by moving the cursor to the spot and pressing F8. This works in any scrollable area, such as a list of bookshelves, a list of books, or the text in a topic.

Scrolling through a long list of bookshelves
Some systems have hundreds of BookManager bookshelves installed. To scroll faster through these long lists, use the ISPF method of specifying the scroll amount on the command line, then pressing F8 (or F7). For example, if the OS/390 bookshelves start at line 520 in the bookshelf list, entering 520 and pressing F8 at the beginning of the list scrolls to the part of the list where the OS/390 bookshelves begin.

Entering **m** and pressing F7 starts you back at the beginning of the bookshelf list again.
Setting a "repeat find" function key

If you've issued a search (or the FIND command with an operand) and you want to find the next occurrence of the word or phrase you're looking for, you can issue the FIND command without operands. It might be handy to set a function key that you don't otherwise use to the FIND command. To do this, enter the KEYS command on the command line, type over a key definition (don't forget the description on the right side of the panel), and use the File pull-down menu to save the new key definitions.
If you especially like or dislike anything about this book, please use one of the methods listed below to send your comments to IBM. Whichever method you choose, make sure you send your name, address, and telephone number if you would like a reply.

Feel free to comment on specific errors or omissions, accuracy, organization, subject matter, or completeness of this book. However, the comments you send should pertain to only the information in this manual and the way in which the information is presented. To request additional publications, or to ask questions or make comments about the functions of IBM products or systems, you should talk to your IBM representative or to your IBM authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes appropriate without incurring any obligation to you.

If you are mailing an RCF from a country other than the United States, you can give the RCF to the local IBM branch office or IBM representative for postage-paid mailing:

- If you prefer to send comments by mail, use the RCF at the back of this book.
- If you prefer to send comments by FAX, use this number:
  - FAX: (International Access Code)+1+914+432-9405
- If you prefer to send comments electronically, use this network ID:
  - IBMLink: (United States customers only): KGNVMC(MHVRCFS)
  - IBM Mail Exchange: USIB6TC9 at IBMMAIL
  - Internet e-mail: mhvrcfs@vnet.ibm.com

Make sure to include the following in your note:

- Title and publication number of this book
- Page number or topic to which your comment applies

 Optionally, if you include your telephone number, we will be able to respond to your comments by phone.
Reader’s Comments — We’d Like to Hear from You

OS/390
BookManager READ/MVS
Hints and Tips
Publication No. GC28-1987-02

You may use this form to communicate your comments about this publication, its organization, or subject matter, with the understanding that IBM may use or distribute whatever information you supply in any way it believes appropriate without incurring any obligation to you. Your comments will be sent to the author’s department for whatever review and action, if any, are deemed appropriate.

Note: Copies of IBM publications are not stocked at the location to which this form is addressed. Please direct any requests for copies of publications, or for assistance in using your IBM system, to your IBM representative or to the IBM branch office serving your locality.

Today's date: ______________________________

What is your occupation?

Newsletter number of latest Technical Newsletter (if any) concerning this publication:

How did you use this publication?

[ ] As an introduction [ ] As a text (student)
[ ] As a reference manual [ ] As a text (instructor)
[ ] For another purpose (explain)

Is there anything you especially like or dislike about the organization, presentation, or writing in this manual? Helpful comments include general usefulness of the book; possible additions, deletions, and clarifications; specific errors and omissions.

Page Number: Comment:

Name __________________________________________________________

Address ________________________________________________________

Company or Organization _________________________________________

Phone No. ______________________________________________________
Reader's Comments — We'd Like to Hear from You
GC28-1987-02

Fold and Tape
Please do not staple
Fold and Tape

BUSINESS REPLY MAIL
FIRST-CLASS MAIL   PERMIT NO. 40   ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

IBM Corporation
Department 55JA, Mail Station P384
522 South Road
Poughkeepsie NY 12601-5400